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Introduction  

This user guide is split in two parts, first covering the Midi Fighter 64 hardware, then the second 
covering the Midi Fighter Utility and all relevant device settings.  

If you are simply looking to learn how to set up and use an existing mapping in either Traktor or 
Ableton, please refer to the quick start guides, these are both available here.  

djtechtools.com/midifighterhelp 


Nomenclature  
The Musical Instrument Device Interface (MIDI) protocol at its most basic level describes 16 
channels, each consisting of 128 Notes, and 128 Control Change (CC) messages.  

This user guide and the Midi Fighter Utility refers to these 16 channels as channels 0 through 
15, the notes as notes 0 through 127, and the control change messages as CC’s 0 through 
127.  
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The Midi Fighter 64 Hardware  

This section describes the hardware & MIDI operation of the Midi Fighter 64 in detail and should 
be used as a reference when creating your own MIDI mapping in your software of choice.  

This section assumes that the reader is already familiar with the basics of the MIDI protocol.  

Introduction  
The Midi Fighter 64 consists of 64 high quality arcade triggers with MIDI controlled full color ring 
illumination. Each of these triggers will send a different note when pressed and offer a optional 
CC message that triggers along it for momentary secondary control.  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Arcade Triggers  
Each trigger sends a Note On when pressed and a Note Off once released. Since these triggers 
are not velocity sensitive the velocity defaults to 127. This value may be adjusted using the 
Utility. By default all arcade trigger notes are sent on MIDI Channel 3.  

If the ‘Note+CC’ option is enabled then the Midi Fighter 64 arcade triggers will also send CC’s. 
When the trigger is pressed a CC with value 127 is sent, when the trigger is released a CC with 
value 0 is sent. Momentary CC’s are sent on Channel 4.  

This is useful for control of effects in Ableton, where note messages will only toggle the effect 
each time the button is pressed and released. By mapping to a CC rather than the Note you 
can create a mapping where the effect is on while the button is down, and off when the button 
is released.  

In Appendix 1 you will find a complete list of MIDI data for each button.  

Setting Arcade Trigger Color  

The ring illumination color of the arcade triggers has two states, active (pressed) and inactive 
(released). 

By using MIDI messages the user can access a much more complete palette which overrides 
the default inactive/active color setting and control both the color and animation state of each 
arcade trigger ring.  

To set the color send a MIDI Note On of the same pitch and channel as the arcade trigger you 
are trying to control. The velocity of the note will determine the color selected. A velocity of 0 will 
disable MIDI control of color.  

e.g. To set the color of the first arcade trigger to Bright Red send a Ch3 E3 Note On of 
Velocity 5. 

Fig 2 MIDI Color Velocity Settings  
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Setting Arcade Trigger Animation State  

By sending MIDI Notes of a particular velocity it is also possible to set a variety of animation 
states for each ring, these animations modify the color state of the ring illumination.  

The available animation states are,  

Brightness Level | Velocity 18 - 33  

This animation allows the user to set the brightness of the current color to one of 16 
brightness levels between 0 and 100%. This is useful for creating VU meters. 

Gate | Velocity 34 - 41  

Allows the user to gate (flash) the current color at one of 8 different rates. If a MIDI clock 
signal is present the timing is derived from that, otherwise the timing is based on a half 
second interval which is the equivalent of 120 BPM. This is useful for creating warnings, 
for example in Traktor you could map the Track End Warning output to flash an LED 
when the track is nearing its end.  

Pulse | Velocity 42 - 49  

Similar to the Gate animation this allows the user to pulse the current color at one of 8 
different rates. If a MIDI clock is present the timing is derived from that otherwise the 
timing is based on a half second interval which is the equivalent of 120 BPM. This 
animation is useful for creating subtle alerts, for example in Traktor you could map the 
Loop On output to control the pulse rate to reflect that the loop is active, and what 
length it is set to.  

Geometry | Velocity 50 - 53 

Like the Spark animation available in the 3D and Spectra, Geometry animations trigger a 
light display that affect the active button and ones near it in a specific pattern. Available 
patterns are: Square, Circle, Star and Triangle. 

To set the animation state of a given arcade trigger ring send a Note On message of the same 
Note but 3 octaves lower and on Channel 4.  

I.e. To set the animation state of the first arcade trigger to Gate 1/4 send a Ch4 E0 Note On of 
Velocity 39.  

It is important to note that the MIDI color setting and MIDI animation setting can be used in 
conjunction.  

i.e. To set the first arcade trigger to Bright Red flashing at a rate of 1/2 first send the color 
information with a Ch3 C3 Note On of Velocity 13, then the animation setting with a Ch4 E0 
Note On of Velocity 39.  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Banks Modes 
The Midi Fighter 64 defaults to banked mode. In this mode the 64 arcade buttons send different 
notes depending on which bank is currently selected. All arcade button notes are sent on 
channel 3 for Bank 1 and channel 2 for Bank 2. All other messages are sent on channels 4 - 6. 

The bank selection can be changed by holding the top right button for 2 seconds to access 
Bank 2 or the top left button to return to Bank 1. This allows you to still use those buttons for 
sweeps or risers that ease transitions between Sound Packs. Colors can be set individually the 
buttons on each bank via the MF Utility so it’s easier to tell them apart. Banks buttons also send 
midi signal as detailed in the Advanced Bank Control section below. 

Corner Button Bank Change 
If you do not wish to use banks when creating your own midi mapping you can set the “Corner 
Button Bank Change” setting to “Disabled” using the Midi Fighter Utility software. When this 
mode is disabled the arcade buttons will send the MIDI data specific to Bank 1 

Hold 
In this mode the bank buttons behave like any normal button, sending a note on when held, 
and a note off when released. By holding the top left or right buttons for 2 seconds you can 
navigate between the virtual banks available in your device.  

Press 
Similar to Hold but removes the 2 second delay, making bank changes happen instantly. 

Disabled 
Disables bank functionality altogether and MIDI notes sent by the arcade buttons are sent 
on channel 3, matching the first bank layout. 

Advanced Bank Control  
It is also possible to use MIDI to read and set the currently selected bank.  

When the virtual bank selection changes the Midi Fighter 64 sends an updated CC value to 
indicate a new bank has been selected. By default the bank selection notes are sent on MIDI 
Channel 3.  

I.e. When changing from Bank 1 to Bank 2 the Midi Fighter will send a Ch3 CC03 with velocity  
of value 1. 

By using MIDI Out on your software of choice and sending a CC message to the MIDI Fighter 
64 it is also possible to force it to automatically change to a specific bank.  

Bank Change CC  
Bank 1 | Ch.3 CC 03 Velocity 0    Bank 2 | Ch.3 CC 03 Velocity 1-127  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The Midi Fighter Utility Software  

This section covers the Midi Fighter Utility software. This is an application for PC & Mac that can 
be used to control, configure, and update your Midi Fighter 64.  

Getting Started  
The Midi Fighter Utility software can be downloaded using the following links. Version 2.68 or 
higher is required to use with your Midi Fighter 64 

Download For Mac  

Download For PC  

Once this has been installed you will find a shortcut on your desktop if using PC, or you can find 
the utility in your Applications folder if using Mac.  

To get started launch the application and connect your Midi Fighter 64 to a spare USB port.  

Note: If the Midi Fighter Utility does not detect your controller please make sure all other MIDI 
software has been shut down, then restart the utility and reconnect the device. 
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Firmware Update  
It is important to ensure your device is loaded with the latest firmware. You can tell if you need 
to update your firmware by looking at the device information section. 

If the device firmware needs to be updated the “Update Firmware” button will display in orange, 
and the text “new firmware available” will display in red. If the firmware is already up to date the 
‘Update Firmware’ button will display in grey and the text “up to date” will appear in green.  

To update the device firmware simply click the update firmware button.  

Note: When updating the firmware do not connect the Midi Fighter 64 via a USB Hub, this may 
lead to a bricked device.  

Performing a Factory Reset  
Using the Midi Fighter Utility it is possible to restore all device settings and color information 
back to the factory defaults. If you are having trouble with your Midi Fighter 64 this can be a 
good place to start when diagnosing the problem.  

To perform a factory reset connect your Midi Fighter 64 to the Utility and in the menu bar click,  

Tools>Midi Fighter>Factory Reset  

Importing & Exporting Settings  
It is possible to import and export device settings, this is useful for saving and sharing device 
settings and color information used for a particular mappings.  

To export your settings click File>Export Settings and enter the name you wish to save the file 
under.  

To import your settings click File>Import Settings and select the settings file you wish to load.  

Note: Once these settings are loaded you must still press “Send to Midi Fighter” to save them to 
the device.  
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Color Settings  
The right hand side of the Midi Fighter Utility interface is used for configuring the color of the 
arcade rim lighting. You can set the color for both the active (pressed) and inactive (released) 
state for each arcade trigger. Note that you can click a button and then drag across other 
buttons, to set the color of many buttons quickly. 

To choose your color settings first pick a color from the palette tool.  

To apply this color to the inactive state click in the outer rim of the desired button.  

�  

To apply this color to the active state click in the center of the desired button.  

�  

Once you are happy with your changes you must save them by click the “Send To Midi Fighter” 
button.  

�  

Note: More colors are available by sending specific MIDI messages to the unit as 
detailed on page 4 of this guide.  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Device Settings  
On the left side of the Utility interface are a number of device hardware settings.  

MIDI Channel 

This sets the base MIDI channel that the Midi Fighter will send and receive MIDI data on. The 
Midi Fighter 64 uses 3 channels and the second and third channels will follow the base channel 
sequentially.  

MIDI Velocity  

The Midi Fighter triggers & buttons are not velocity sensitive. This setting sets the default 
velocity for Note On messages from the Midi Fighter.  

MIDI Type 

• Notes - useful for drum racks and toggle mapping in general) 

• CCs - useful when momentary action is required) 

• Notes+CCs - previously referred as “Ableton Mode” in other Midi Fighter models, in this mode 
arcade triggers will send both Note & Control Change messages. This is useful when using 
the device in Ableton as it allows you to map momentary control of FX to the arcade triggers, 
whereas Note On messages will only provide toggle control. 

Corner Button Bank Change 

There are 2 banks available in the 64, accessible by holding down the top right button for 2 
seconds to enter Bank 2 and holding the top left button to return to Bank 1. The original 
message for those buttons are still sent to enable smoother Sound Pack changes. This 
functionality can be disabled from the MF Utility.  Other options are available as detailed on 
page 6 of this guide. 

Sleep Timer  

The Midi Fighter 64 can be configured to sleep after a certain period of inactivity. You can 
configure the sleep timer to be between 0 and 120 minutes. A setting of 0 will disable sleep. 
Pressing any button will wake the Midi Fighter from sleep.  

Combos  

The Combos check box enables sending of ‘Super Combo’ MIDI notes. These are special 
notes sent only when specific patterns of arcade triggers are pressed, just like an arcade game. 
The full details of the super combos are secret, but details can be found on the Midi Fighter 
forum! Currently these are only available in the lower left quadrant.  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Animations 

The animations section allows you to configure the various global animations settings for the 
Midi Fighter 64 display. If you prefer to have these per button make sure set this to None so you 
don’t have overlapping animations. 

• Square 

• Circle 

• Star 

• Triangle 

• None 

Note: Per button animations are available via MIDI Out, sent on Notes/CC 0-63 for Bank 1 and 
64-127 for Bank 2 on Ch.4 (e.g. Animations for the top left arcade button are sent to CC28 Ch4 or  
Note E0 Ch.4 )  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Appendix 1 
MIDI Messages (Bank 1) 

Control Note Ch Note Note/CC # CC & Anim Ch. Note/CC #

Arcade Button 1 3 C1 36 4 0

Arcade Button 2 3 C#1 37 4 1

Arcade Button 3 3 D1 38 4 2

Arcade Button 4 3 D#1 39 4 3

Arcade Button 5 3 E1 40 4 4

Arcade Button 6 3 F1 41 4 5

Arcade Button 7 3 F#1 42 4 6

Arcade Button 8 3 G1 43 4 7

Arcade Button 9 3 G#1 44 4 8

Arcade Button 10 3 A1 45 4 9

Arcade Button 11 3 A#1 46 4 10

Arcade Button 12 3 B1 47 4 11

Arcade Button 13 3 C2 48 4 12

Arcade Button 14 3 C#2 49 4 13

Arcade Button 15 3 D2 50 4 14

Arcade Button 16 3 D#2 51 4 15

Arcade Button 17 3 E2 52 4 16

Arcade Button 18 3 F2 53 4 17

Arcade Button 19 3 F#2 54 4 18

Arcade Button 20 3 G2 55 4 19

Arcade Button 21 3 G#2 56 4 20

Arcade Button 22 3 A2 57 4 21

Arcade Button 23 3 A#2 58 4 22

Arcade Button 24 3 B2 59 4 23

Arcade Button 25 3 C3 60 4 24

Arcade Button 26 3 C#3 61 4 25

Arcade Button 27 3 D3 62 4 26

Arcade Button 28 3 D#3 63 4 27

Arcade Button 29 3 E3 64 4 28

Arcade Button 30 3 F3 65 4 29

Arcade Button 31 3 F#3 66 4 30
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* CC only available when “Notes+CCs” mode is active in the Utility 

Arcade Button 32 3 G3 67 4 31

Arcade Button 33 3 G#3 68 4 32

Arcade Button 34 3 A3 69 4 33

Arcade Button 35 3 A#3 70 4 34

Arcade Button 36 3 B3 71 4 35

Arcade Button 37 3 C4 72 4 36

Arcade Button 38 3 C#4 73 4 37

Arcade Button 39 3 D4 74 4 38

Arcade Button 40 3 D#4 75 4 39

Arcade Button 41 3 E4 76 4 40

Arcade Button 42 3 F4 77 4 41

Arcade Button 43 3 F#4 78 4 42

Arcade Button 44 3 G4 79 4 43

Arcade Button 45 3 G#4 80 4 44

Arcade Button 46 3 A4 81 4 45

Arcade Button 47 3 A#4 82 4 46

Arcade Button 48 3 B4 83 4 47

Arcade Button 49 3 C5 84 4 48

Arcade Button 50 3 C#5 85 4 49

Arcade Button 51 3 D5 86 4 50

Arcade Button 52 3 D#5 87 4 51

Arcade Button 53 3 E5 88 4 52

Arcade Button 54 3 F5 89 4 53

Arcade Button 55 3 F#5 90 4 54

Arcade Button 56 3 G5 91 4 55

Arcade Button 57 3 G#5 92 4 56

Arcade Button 58 3 A5 93 4 57

Arcade Button 59 3 A#5 94 4 58

Arcade Button 60 3 B5 95 4 59

Arcade Button 61 3 C6 96 4 60

Arcade Button 62 3 C#6 97 4 61

Arcade Button 63 3 D6 98 4 62

Arcade Button 64 3 D#6 99 4 63

Control Note Ch Note Note/CC # CC & Anim Ch. Note/CC #
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MIDI Messages (Bank 2) 

Control Note Ch Note Note/CC # CC & Anim Ch. CC #*

Arcade Button 1 2 C1 36 4 64

Arcade Button 2 2 C#1 37 4 65

Arcade Button 3 2 D1 38 4 66

Arcade Button 4 2 D#1 39 4 67

Arcade Button 5 2 E1 40 4 68

Arcade Button 6 2 F1 41 4 69

Arcade Button 7 2 F#1 42 4 70

Arcade Button 8 2 G1 43 4 71

Arcade Button 9 2 G#1 44 4 72

Arcade Button 10 2 A1 45 4 73

Arcade Button 11 2 A#1 46 4 74

Arcade Button 12 2 B1 47 4 75

Arcade Button 13 2 C2 48 4 76

Arcade Button 14 2 C#2 49 4 77

Arcade Button 15 2 D2 50 4 78

Arcade Button 16 2 D#2 51 4 79

Arcade Button 17 2 E2 52 4 80

Arcade Button 18 2 F2 53 4 81

Arcade Button 19 2 F#2 54 4 82

Arcade Button 20 2 G2 55 4 83

Arcade Button 21 2 G#2 56 4 84

Arcade Button 22 2 A2 57 4 85

Arcade Button 23 2 A#2 58 4 86

Arcade Button 24 2 B2 59 4 87

Arcade Button 25 2 C3 60 4 88

Arcade Button 26 2 C#3 61 4 89

Arcade Button 27 2 D3 62 4 90

Arcade Button 28 2 D#3 63 4 91

Arcade Button 29 2 E3 64 4 92

Arcade Button 30 2 F3 65 4 93

Arcade Button 31 2 F#3 66 4 94

Arcade Button 32 2 G3 67 4 95

Arcade Button 33 2 G#3 68 4 96

Arcade Button 34 2 A3 69 4 97
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* CC only available when “Notes+CCs” mode is active in the Utility 

Arcade Button 35 2 A#3 70 4 98

Arcade Button 36 2 B3 71 4 99

Arcade Button 37 2 C4 72 4 100

Arcade Button 38 2 C#4 73 4 101

Arcade Button 39 2 D4 74 4 102

Arcade Button 40 2 D#4 75 4 103

Arcade Button 41 2 E4 76 4 104

Arcade Button 42 2 F4 77 4 105

Arcade Button 43 2 F#4 78 4 106

Arcade Button 44 2 G4 79 4 107

Arcade Button 45 2 G#4 80 4 108

Arcade Button 46 2 A4 81 4 109

Arcade Button 47 2 A#4 82 4 110

Arcade Button 48 2 B4 83 4 111

Arcade Button 49 2 C5 84 4 112

Arcade Button 50 2 C#5 85 4 113

Arcade Button 51 2 D5 86 4 114

Arcade Button 52 2 D#5 87 4 115

Arcade Button 53 2 E5 88 4 116

Arcade Button 54 2 F5 89 4 117

Arcade Button 55 2 F#5 90 4 118

Arcade Button 56 2 G5 91 4 119

Arcade Button 57 2 G#5 92 4 120

Arcade Button 58 2 A5 93 4 121

Arcade Button 59 2 A#5 94 4 122

Arcade Button 60 2 B5 95 4 123

Arcade Button 61 2 C6 96 4 124

Arcade Button 62 2 C#6 97 4 125

Arcade Button 63 2 D6 98 4 126

Arcade Button 64 2 D#6 99 4 127

Control Note Ch Note Note/CC # CC & Anim Ch. CC #*
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Appendix 2 
Animation Settings 

Note: Animations are sent on Notes/CC 0-63 for Bank 1 and 64-127 for Bank 2 on Ch.4 (e.g. 
Animations for the top left arcade button are sent to CC28 Ch4 or  Note E0 Ch.4 ) 

Velocity / CC Value Animation Setting

0 - 17 None -

18-33 Brightness Level 0-15

34 Gate Toggles every 16 beats

35 Gate Toggles every 8 beats

36 Gate Toggles every 4 beats

37 Gate Toggles every 2 beats

38 Gate Toggles every beat

39 Gate Toggles every 1/2 beat

40 Gate Toggles every 1/4 beat

41 Gate Toggles every 1/8 beat

42 Pulse Pulses every 32 beats

43 Pulse Pulses every 16 beats

44 Pulse Pulses every 8 beats

45 Pulse Pulses every 4 beats

46 Pulse Pulses every 2 beats

47 Pulse Pulses every beat

48 Pulse Pulses every 1/2 beat

49 Pulse Pulses every 1/8 beat

50 Geometric Square Animation

51 Geometric Circle Animation

52 Geometric Star Animation

53 Geometric Triangle Animation

54 - 127 None -
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